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1. Penting

1.	 Penting
Buku petunjuk elektronik ini ditujukan untuk 
siapapun yang menggunakan monitor Philips. 
Luangkan waktu untuk membaca panduan 
pengguna sebelum menggunakan monitor. 
Panduan tersebut berisi informasi dan catatan 
penting tentang cara mengoperasikan monitor.

Jaminan Philips berlaku pada produk yang 
penggunaannya ditangani dengan baik sesuai 
dengan petunjuk pengoperasian dan atas 
presentasi faktur asli atau resi yang menunjukkan 
tanggal pembelian, nama dealer, nomor model, 
dan nomor produksi produk.

1.1	 Tindakan pencegahan dan 
pemeliharaan

	 Peringatan
Penggunaan kontrol, penyesuaian, maupun 
prosedur selain yang dijelaskan dalam 
dokumentasi ini dapat mengakibatkan sengatan 
listrik, bahaya listrik, dan/atau bahaya mekanis.

Baca dan ikuti petunjuk ini saat menyambungkan 
dan menggunakan monitor komputer.

Pengoperasian

•	 Jauhkan monitor dari sinar matahari 
langsung, cahaya yang sangat terang, dan 
sumber panas lainnya. Pemaparan dalam 
waktu lama terhadap jenis lingkungan 
tersebut dapat mengakibatkan perubahan 
warna dan kerusakan pada monitor.

•	 Pindahkan objek apapun yang dapat jatuh 
ke lubang ventilasi atau mungkin mencegah 
pendinginan elektronik yang benar pada 
monitor. 

•	 Jangan halangi lubang ventilasi pada kabinet.
•	 Saat menetapkan posisi monitor, pastikan 

konektor daya dan stopkontak mudah 
dijangkau.

•	 Jika mematikan monitor dengan melepaskan 
kabel daya atau kabel daya DC, tunggu 
selama 6 detik sebelum memasang 

kabel daya atau kabel daya DC untuk 
pengoperasian biasa.

•	 Selalu gunakan kabel daya yang disetujui dan 
disediakan oleh Philips. Jika kabel daya tidak 
ada, hubungi pusat layanan setempat. (Lihat 
Pusat Informasi Layanan Pelanggan)

•	 Jaga agar monitor terhindar dari getaran 
kencang atau kondisi berbahaya lainnya 
selama pengoperasian berlangsung.

•	 Jaga agar monitor tidak terjatuh atau 
terbentur selama pengoperasian atau 
pengiriman.

Pemeliharaan

•	 Untuk melindungi monitor dari 
kemungkinan kerusakan, jangan letakkan 
benda berat di atas panel LCD. Saat 
memindahkan monitor, pegang bingkai 
untuk mengangkat, jangan angkat monitor 
dengan meletakkan tangan atau jari pada 
panel LCD.

•	 Lepas sambungan monitor jika Anda tidak 
akan menggunakannya dalam waktu lama.

•	 Lepas sambungan monitor jika Anda 
akan membersihkannya dengan kain yang 
lembab. Layar dapat dibersihkan dengan 
kain yang kering saat dimatikan. Namun, 
jangan pernah gunakan larutan organik, 
seperti alkohol atau cairan beramonia untuk 
membersihkan monitor.

•	 Untuk menghindari risiko sengatan listrik 
atau kerusakan permanen, jangan biarkan 
monitor terkena debu, hujan, atau air, 
maupun berada dalam lingkungan dengan 
kelembaban berlebihan.

•	 Jika monitor basah, segera seka dengan kain 
kering.

•	 Jika benda asing atau air masuk ke dalam 
monitor, segera matikan daya dan lepas 
kabel daya. Setelah itu, keluarkan benda 
asing atau air tersebut, lalu bawa ke pusat 
pemeliharaan.

•	 Jangan simpan atau gunakan monitor di 
lokasi yang bersuhu panas, terkena sinar 
matahari langsung, atau bersuhu sangat 
dingin.

•	 Untuk memelihara performa terbaik 
monitor dan memperpanjang masa 
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pakainya, gunakan monitor di lokasi dalam 
kisaran suhu dan kelembaban berikut. 
•	 Suhu: 0-40°C 32-95°F

•	 Kelembaban: 20-80% RH

Informasi penting untuk Efek Terbakar/
Bayangan Gambar

•	 Aktifkan selalu program screensaver 
bergerak bila Anda meninggalkan monitor. 
Aktifkan selalu aplikasi refresh layar berkala 
jika monitor akan menampilkan konten 
statis yang tidak berubah. Tampilan gambar 
diam atau gambar statis yang tidak berubah 
dalam waktu lama dapat menimbulkan “efek 
terbakar”, disebut juga “jejak gambar” atau 
“bayangan”, di layar. 
"Efek terbakar", "jejak gambar", atau 
"bayangan" adalah fenomena umum dalam 
teknologi panel LCD. Dalam sebagian besar 
kasus, “efek terbakar”, “jejak gambar”, 
atau “bayangan” akan menghilang secara 
bertahap dalam waktu tertentu setelah daya 
dimatikan. 

	 Peringatan
Kegagalan mengaktifkan screensaver, atau aplikasi 
refresh layar secara berkala dapat menyebabkan 
gejala parah "efek terbakar", "jejak gambar", atau 
bayangan gambar" yang tidak akan menghilang 
dan tidak dapat diperbaiki. Kerusakan yang 
disebutkan di atas tidak tercakup dalam jaminan 
Anda.

Layanan

•	 Penutup casing hanya dapat dibuka oleh 
teknisi ahli.

•	 Jika harus memperbaiki atau mengintegrasi 
dokumen, hubungi pusat layanan setempat. 
(lihat bab "Pusat Informasi Konsumen") 

•	 Untuk informasi pengiriman, lihat "Spesifikasi 
Teknis". 

•	 Jangan tinggalkan monitor di dalam mobil/
bagasi di bawah sinar matahari langsung.

	 Catatan
Hubungi teknisi servis jika monitor tidak 
beroperasi secara normal atau Anda tidak yakin 
dengan prosedur yang harus dilakukan bila 
petunjuk pengoperasian yang diberikan telah 
diikuti.
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1.2	 Keterangan Penulisan

Subbab berikut menjelaskan konvensi penulisan 
yang digunakan dalam dokumen ini.

Catatan, Perhatian, dan Peringatan

Dalam buku petunjuk ini, beberapa teks mungkin 
disertai ikon dan dicetak dengan huruf tebal atau 
miring. Teks tersebut berisi catatan, perhatian, 
atau peringatan yang digunakan sebagai berikut:

	 Catatan
Ikon ini menunjukkan informasi penting dan 
tips yang akan membantu Anda memanfaatkan 
sistem komputer dengan lebih baik.

	 Perhatian
Ikon ini menunjukkan informasi yang 
memberitahukan Anda tentang cara menghindari 
kemungkinan kerusakan perangkat keras atau 
hilangnya data.

	 Peringatan
Ikon ini menunjukkan kemungkinan cedera 
dan memberitahukan Anda tentang cara 
menghindarinya.

Beberapa peringatan mungkin ditulis dalam 
format lain dan mungkin tidak disertai dengan 
ikon. Dalam hal ini, penulisan peringatan tertentu 
diwajibkan oleh peraturan pemerintah terkait.

1.3	 Pembuangan produk dan materi 
kemasan

Waste Electrical and Electronic Equipment-
WEEE

This marking on the product or on its 
packaging illustrates that, under European 
Directive 2012/19/EU governing used electrical 
and electronic appliances, this product may 
not be disposed of with normal household 
waste. You are responsible for disposal of 
this equipment through a designated waste 
electrical and electronic equipment collection. 
To determine the locations for dropping off 
such waste electrical and electronic, contact 
your local government office, the waste disposal 
organization that serves your household or the 
store at which you purchased the product.
Your new monitor contains materials that can 
be recycled and reused. Specialized companies 
can recycle your product to increase the 
amount of reusable materials and to minimize 
the amount to be disposed of. 
All redundant packing material has been 
omitted. We have done our utmost to make the 
packaging easily separable into mono materials.

Please find out about the local regulations on 
how to dispose of your old monitor and packing 
from your sales representative. 
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Taking back/Recycling Information for 
Customers

Philips establishes technically and economically 
viable objectives to optimize the environmental 
performance of the organization's product, 
service and activities.

From the planning, design and production 
stages, Philips emphasizes the important of 
making products that can easily be recycled.  At 
Philips, end-of-life management primarily entails 
participation innational take-back initiatives 
and recycling programs whenever possible, 
preferably in cooperation with competitors,  
which recycle  all materials (products and 
related packaging material) in accordance with 
all Environmental Laws and taking back program 
with the contractor company.  

Your display is manufactured with high quality 
materials and components which can be 
recycled and reused.

To learn more about our recycling program 
please visit 

http://www.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/
productrecyclingservices.page

http://www.philips.com/sites/philipsglobal/about/sustainability/ourenvironment/productrecyclingservices.page
http://www.philips.com/sites/philipsglobal/about/sustainability/ourenvironment/productrecyclingservices.page
http://www.philips.com/sites/philipsglobal/about/sustainability/ourenvironment/productrecyclingservices.page
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2.	 Memasang monitor

2.1	 Pemasangan

	 Isi kemasan

* VGA  

* DVI 

* Depends on the country

Register your product and get support at

www.philips.com/welcome

Quick

Start

©
 2014 Koninklijke Philips N

.V. All rights reserved. Unauthorized duplication is a violation of applicable laws. Made and printed in Chin
a. V

ers
ionPhilips and the Philips’ Shield Emblem are registered trademarks of 

Koninklijke Philips N.V. and are used under license from Koninklijke 
Philips N.V.

Monitor drivers
SmartControl software

User’s Manual

  

使用 前请阅读使用说明

保留备用

	 Memasang dudukan dasar
1.	 Letakkan monitor menghadap ke bawah 

pada permukaan yang halus dan lembut 
agar layar tidak tergores atau rusak.

2.	 Pasang batang dudukan ke monitor hingga 
terdengar bunyi klik pada posisinya.

3.	 Pegang dudukan dasar monitor dengan 
kedua tangan dan masukkan dudukan dasar 
dengan kuat ke dalam batang dudukan.

* Tergantung pada negara
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	 Menyambungkan ke PC

4

	 Input daya AC
	 Input VGA
	 Input DVI-D (tersedia untuk model tertentu)
	 Kunci antipencurian Kensington

Menyambung ke PC

1.	 Sambungkan kabel daya dengan kuat ke 
bagian belakang monitor.

2.	 Matikan komputer dan lepas kabel daya.

3.	 Sambungkan kabel sinyal monitor ke 
konektor video di bagian belakang 
komputer.

4.	 Sambungkan kabel daya komputer dan 
monitor ke stopkontak di sekitar.

5.	 Hidupkan komputer dan monitor. Jika 
monitor menampilkan gambar, berarti 
pemasangan telah selesai.

2.2	 Mengoperasikan monitor

	 Keterangan produk bagian depan

Model 200V4Q:

5

6 2347

Menghidupkan dan mematikan 
daya monitor.

Mengakses menu OSD. 
Konfirmasikan penyesuaian OSD.

Kembali ke tingkat OSD 
sebelumnya.

Sesuaikan tingkat kecerahan. 

Menyesuaikan menu OSD.

Ubah format tampilan.

Secara otomatis menyesuaikan 
monitor.

	 Keterangan On Screen Display
Apakah yang dimaksud dengan OSD (On-
Screen Display)?
OSD (On-Screen Display) adalah fitur yang 
terdapat pada semua monitor LCD Philips. 
Pengguna akhir dapat menggunakannya untuk 
menyesuaikan performa layar atau memilih fungsi 
monitor secara langsung melalui jendela petunjuk 
di layar. Antarmuka tampilan di layar yang mudah 
digunakan muncul seperti di bawah ini:
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Model 200V4Q:












 

Petunjuk dasar dan mudah pada tombol kontrol
Pada OSD yang ditampilkan di atas, Anda 
dapat menekan tombol   pada bezel depan 
monitor untuk menggerakkan kursor, lalu tekan 
tombol OK untuk mengonfirmasikan pilihan 
atau perubahan.

Menu OSD

Berikut adalah tampilan keseluruhan dari 
struktur On-Screen Display. Anda dapat 
menggunakannya sebagai referensi bila ingin 
melakukan penyesuaian lainnya nanti.

Main menu Sub menu

Picture

OSD Settings
0~100

0~100

Off, 1, 2, 3, 4

5s, 10s, 20s, 30s, 60s

Horizontal

Vertical

Transparency

OSD Time Out

Setup

0~100

On, Off

Yes, No

0~100

0~100

0~100

H. Position

Auto

V. Position

Phase

Clock

Resolution Notification

Reset

Information

Language

Color
6500K, 9300K

Red: 0~100

Green: 0~100

Blue: 0~100

Color Temperature

sRGB

User Define

VGA

DVI
Input

Wide Screen, 4:3
0~100

0~100

Picture Format
Brightness

Contrast
Off, Fast, Faster, FastestSmartResponse

available for selective models

On, OffSmartContrast
On, OffPixel Orbiting
(1.8, 2.0, 2.2, 2.4, 2.6)Gamma

English, Deutsch, Español, Ελληνική, Français, Italiano,
Maryar, Nederlands, Português, Português do Brazil,
Polski , Русский, Svenska, Suomi, Türkçe, Čeština,
Українська, 简体中文, 繁體中文,日本語,한국어



8

2. Memasang monitor

	 Pemberitahuan resolusi

Monitor ini dirancang untuk memberikan 
performa optimal pada resolusi aslinya, 
yakni 1920X1080 pada 60 Hz. Bila monitor 
dihidupkan pada resolusi yang berbeda, layar 
akan menampilkan peringatan: Gunakan 
1920X1080 pada 60 Hz untuk hasil terbaik.

Tampilan peringatan resolusi asli dapat 
dinonaktifkan dari Setup (Konfigurasi) dalam 
menu OSD (Tampilan di Layar).

	 Fungsi Fisik

Kemiringan

2.3	 Melepas Dudukan dan Dudukan 
Dasar

	 Melepas Dudukan Dasar

Sebelum mulai membongkar penyangga 
monitor, ikuti petunjuk di bawah ini agar 
terhindar dari kemungkinan kerusakan atau 
cedera.

1.	 Letakkan monitor menghadap ke bawah 
pada permukaan yang halus agar layar tidak 
tergores atau rusak.

2.	 	Tekan klip pengunci untuk melepas dudukan 
dasar dari batang dudukan.

1

3.	 Tekan tombol pelepas untuk melepas 
batang dudukan.

2
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	 Note 
This monitor accepts a 100mm x 100mm VESA-
Compliant mounting interface.

100mm

100mm



10

3. Pengoptimalan Gambar

3.	 Pengoptimalan Gambar

3.1	 SmartContrast

	� Apakah yang dimaksud dengan 
SmartContrast?

Teknologi unik yang secara dinamis menganalisis 
konten yang ditampilkan serta secara otomatis 
mengoptimalkan rasio kontras monitor LCD 
untuk kejernihan visual dan kenyamanan 
tampilan maksimal dengan menambah cahaya 
lampu latar agar gambar lebih jernih, tajam, 
dan terang, atau mengurangi cahaya lampu 
latar untuk tampilan gambar yang jelas di latar 
belakang gelap.

	 Mengapa saya memerlukannya?
Anda menginginkan kejernihan visual dan 
kenyamanan tampilan terbaik untuk setiap 
jenis konten. SmartContrast secara dinamis 
mengontrol kontras dan menyesuaikan cahaya 
lampu latar agar gambar dalam permainan 
serta video lebih jernih, tajam, dan terang, atau 
menampilkan teks yang jelas dan mudah dibaca 
untuk pekerjaan kantor. Dengan mengurangi 
pemakaian daya monitor, Anda menghemat 
biaya untuk daya dan memperpanjang masa 
pakai monitor.

	 Bagaimana prosedurnya?
Saat diaktifkan, SmartContrast akan menganalisis 
konten yang ditampilkan secara real time 
untuk menyesuaikan warna dan mengontrol 
intensitas cahaya lampu latar. Fungsi ini akan 
secara dinamis menyempurnakan kontras 
untuk pengalaman hiburan yang luar biasa saat 
menonton video atau menjalankan permainan.

3.2	 Philips SmartControl Lite

Perangkat lunak SmartControl Lite baru dari 
Philips memungkinkan Anda mengontrol 
monitor melalui antarmuka grafis layar 
yang mudah digunakan. Penyesuaian rumit 
sebelumnya kini tidak ada lagi karena panduan 
perangkat lunak yang mudah digunakan ini 
akan memandu Anda menyesuaikan resolusi 
penyempurnaan, Kalibrasi warna, Pengaturan 
jam/fase, Pengaturan titik putih RGB, dsb.

Dengan dilengkapi teknologi algoritme inti 
terbaru untuk pemrosesan serta respons yang 
cepat, perangkat lunak berbasis Ikon animasi 
yang menarik dan mendukung Windows ini 
siap menyempurnakan pengalaman Anda 
menggunakan monitor Philips!

	 Penginstalan

•	 Ikuti petunjuk dan selesaikan penginstalan.

•	 Anda dapat mengaktifkannya setelah 
penginstalan selesai.

•	 Jika ingin mengaktifkannya di lain waktu, 
Anda dapat mengklik cara pintas di desktop 
atau toolbar.

Wizard pengaktifan pertama kali

•	 Setelah penginstalan SmartControl Lite 
selesai, Wizard pengaktifan pertama kali 
akan terbuka secara otomatis.

•	 Wizard ini akan memandu Anda 
menyesuaikan performa monitor secara 
bertahap.

•	 Menu Plug-in juga dapat dibuka untuk 
menjalankan wizard di lain waktu.

•	 Anda dapat menyesuaikan pilihan lainnya 
tanpa menggunakan wizard melalui panel 
Standard (Standar).
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	 Memulai dengan panel Standard (Standar):

Menu Adjust (Penyesuaian):

•	 Menu Adjust (Penyesuaian) digunakan 
untuk menyesuaikan Brightness (Kecerahan), 
Contrast (Kontras), Focus (Fokus), Position 
(Posisi), dan Resolution (Resolusi).

•	 Anda dapat mengikuti petunjuk dan 
melakukan penyesuaian.

•	 Cancel (Batal) mengkonfirmasi pengguna 
jika ingin membatalkan penginstalan.
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Menu Color (Warna):

•	 Menu Color (Warna) digunakan untuk 
menyesuaikan RGB, Black Level (Tingkat 
Hitam), White Point (Titik Putih), Color 
Calibration (Kalibrasi Warna).

•	 Anda dapat mengikuti petunjuk dan 
melakukan penyesuaian.

•	 Untuk item submenu berdasarkan input 
Anda, lihat tabel di bawah ini.

•	 Misalnya Color Calibration (Kalibrasi 
Warna).
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1.	 "Show Me" (Tunjukkan) memulai tutorial 
kalibrasi warna.

2.	 Start (Mulai) - memulai urutan kalibrasi 
warna 6 langkah.

3.	 Quick View (Tampilan Ringkas) memuat 
gambar sebelum/sesudah kalibrasi.

4.	 Untuk kembali ke panel awal Color 
(Warna), klik tombol Cancel (Batal).

5.	 Enable color calibration (Aktifkan kalibrasi 
warna) - telah diaktifkan secara default. 
Jika tidak dicentang, kalibrasi warna tidak 
dapat dijalankan serta tombol start (mulai) 
dan quick view (tampilan ringkas) akan 
dinonaktifkan.

6.	 Info paten harus ditampilkan di layar 
kalibrasi.

Layar Kalibrasi warna pertama:

•	 Tombol Previous (Sebelumnya) 
dinonaktifkan hingga layar kalibrasi warna 
kedua ditampilkan.

•	 Next (Berikutnya) menampilkan layar sesuai 
urutan selanjutnya (6 target).

•	 Layar terakhir menampilkan panel 
File>Presets (File>Preset).

•	 Cancel (Batal) menutup antarmuka 
pengguna dan kembali ke halaman plug in.

Options>Preferences (Pilihan>Preferensi) - 
Hanya diaktifkan sewaktu memilih Preferences 
(Preferensi) dari menu drop-down Options 
(Pilihan). Di layar yang tidak didukung, namun 
dilengkapi DDC/CI, hanya tab Help (Bantuan) 
dan Options (Pilihan) yang tersedia.

•	 Menampilkan pengaturan preferensi saat ini.

•	 Jika kotak dicentang, fitur akan diaktifkan. 
Kotak centang berfungsi sebagai pengunci.

•	 Enable Context Menu (Aktifkan Menu 
Konteks) di desktop dicentang (Aktif) 
secara default. Enable Context Menu 
(Aktifkan Menu Konteks) menampilkan 
pilihan Select Preset (Pilih Preset) dan 
Tune Display (Sempurnakan Layar) untuk 
SmartControl Lite dalam menu konteks klik 
kanan di desktop. Disabled (Dinonaktifkan) 
menghapus SmartControl Lite dari menu 
konteks klik kanan tersebut.

•	 Ikon Enable Task Tray (Aktifkan Baki 
Tugas) dicentang (Aktif) secara default. 
Enable Context Menu (Aktifkan menu 
konteks) menampilkan menu baki tugas 
untuk SmartControl Lite. Mengklik kanan 
ikon baki tugas akan menampilkan pilihan 
menu Help (Bantuan), Technical Support 
(Dukungan Teknis), Check for Update 
(Periksa Pembaruan), About (Tentang), dan 
Exit (Keluar). Bila Enable Task Tray menu 
(Aktifkan menu baki tugas) dinonaktifkan, 
ikon baki tugas hanya akan menampilkan 
EXIT (KELUAR).
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•	 Run at Startup (Jalankan Saat Pengaktifan) 
dicentang (Aktif) secara default. Bila 
dinonaktifkan, SmartControl Lite tidak akan 
berjalan saat pengaktifan atau tidak akan 
ditampilkan dalam baki tugas. Satu-satunya 
cara menjalankan SmartControl Lite 
adalah melalui cara pintas desktop atau file 
program. Preset apapun yang ditetapkan 
untuk berjalan saat pengaktifan tidak 
akan dimuat bila kotak ini tidak dicentang 
(Dinonaktifkan).

•	 Enable transparency mode (Aktifkan mode 
transparansi) (Windows 7/8.1, Vista, XP). 
Nilai default adalah 0% Tidak Tembus 
Cahaya.

Options>Input (Pilihan>Input) - Hanya 
diaktifkan sewaktu memilih Input dari menu 
drop-down Options (Pilihan). Di layar yang tidak 
didukung, namun dilengkapi DDC/CI, hanya 
tab Help (Bantuan) dan Options (Pilihan) yang 
tersedia. Semua tab SmartControl Lite lainnya 
tidak tersedia.

•	 Menampilkan panel petunjuk Source 
(Sumber) dan pengaturan sumber input 
saat ini.

•	 Di layar input tunggal, panel ini tidak akan 
ditampilkan.

Options>Audio (Pilihan>Audio) - Hanya 
diaktifkan sewaktu memilih Audio dari menu 
drop-down Options (Pilihan).

Di layar yang tidak didukung, namun dilengkapi 
DDC/CI, hanya tab Help (Bantuan) dan Options 
(Pilihan) yang tersedia.

Help>User Manual (Bantuan>Panduan 
Pengguna) - Hanya diaktifkan sewaktu memilih 
User Manual (Panduan Pengguna) dari menu 
drop-down Help (Bantuan). Di layar yang tidak 
didukung, namun dilengkapi DDC/CI, hanya 
tab Help (Bantuan) dan Options (Pilihan) yang 
tersedia.
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Help>Version (Bantuan>Versi) - Hanya 
diaktifkan sewaktu memilih Version (Versi) dari 
menu drop- down Help (Bantuan). Di layar 
yang tidak didukung, namun dilengkapi DDC/CI, 
hanya tab Help (Bantuan) dan Options (Pilihan) 
yang tersedia.

Menu Sesuai Konteks
Context Sensitive Menu (Menu Sesuai 
Konteks) diaktifkan secara default. Jika Enable 
Context Menu (Aktifkan Menu Konteks) telah 
dicentang dalam panel Options>Preferences 
(Pilihan>Preferensi), menu tersebut akan 
ditampilkan.

Context Menu (Menu Konteks) memiliki tiga 
entri:
•	 SmartControl Lite - Bila dipilih, About 

(Tentang) Layar akan ditampilkan.
•	 Select Preset (Pilih Preset) - Memberikan 

urutan menu preset yang disimpan untuk 
digunakan di lain waktu. Tanda centang 
menunjukkan preset yang saat ini dipilih. 
Preset Pabrik juga dapat dipilih dari menu 
drop down.

•	 Tune Display (Sempurnakan Layar) - 
Membuka panel kontrol SmartControl Lite.

Menu Baki Tugas Diaktifkan
Menu baki tugas dapat ditampilkan dengan 
mengklik kanan ikon SmartControl Lite dari baki 
tugas. Klik kiri akan mengaktifkan aplikasi.

Baki tugas memiliki lima entri:
•	 Help (Bantuan) - Mengakses file User 

Manual (Panduan Pengguna): Buka file User 
Manual (Panduan Pengguna) menggunakan 
jendela browser default.

•	 Technical Support (Dukungan Teknis) - 
Menampilkan halaman dukungan teknis.

•	 Check for Update (Periksa Pembaruan) - 
Mengarahkan pengguna ke Arahan PDI dan 
memeriksa versi pengguna terhadap versi 
terbaru yang tersedia.

•	 About (Tentang) - Menampilkan informasi 
rinci tentang referensi: versi produk, 
informasi edisi, dan nama produk.

•	 Exit (Keluar) - Menutup SmartControl Lite.

Untuk kembali menjalankan SmartControl Lite, 
pilih SmartControl Lite dari menu Program, lalu 
klik dua kali ikon PC desktop, atau hidupkan 
ulang sistem.
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Menu Baki Tugas Dinonaktifkan
Bila Baki Tugas dinonaktifkan dalam folder 
preferensi, maka hanya pilihan EXIT (KELUAR) 
yang tersedia. Untuk menghapus SmartControl 
Lite secara keseluruhan dari baki tugas, 
nonaktifkan Run at Startup (Jalankan Saat 
Pengaktifan) dalam Options>Preferences 
(Pilihan>Preferensi).

 Catatan

Semua ilustrasi pada bagian ini hanya sebagai 
rujukan. Versi software SmartControl mungkin 
berubah tanpa pemberitahuan. Silakan periksa 
situs web resmi Portrait di www.portrait.com/
dtune/phl/enu/index untuk mengunduh versi 
terbaru software SmartControl.
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4.	 Spesifikasi Teknis
Gambar/Layar
Jenis panel LCD MVA LCD
Lampu latar LED
Ukuran panel 19,53" P (49.6 cm)
Rasio aspek 16:9
Jarak Piksel 0,23 x 0,22 mm
Kecerahan 250 cd/m² 
SmartContrast 10,000,000:1
Rasio kontras (biasa) 3000:1 
Waktu respons (biasa) 20ms(200V4QSB)
SmartResponse     8ms(GtG)(200V4QSBR)
Resolusi Optimum 1920×1080@60Hz 
Sudut pandang 178° (H) / 178° (V) @ C/R > 10
Warna layar 16,7M
Kecepatan refresh vertikal 56Hz - 76Hz
Frekuensi Horizontal 30kHz - 83kHz
sRGB YA
Konektivitas
Input sinyal DVI-D (digital) VGA (Analog)
Sinyal Input Sinkronisasi Terpisah, Sinkronisasi pada Nyala Hijau
Kenyamanan
Kenyamanan Pengguna
Bahasa OSD English, Deutsch, Español, Ελληνική, Français, Italiano, Maryar, 

Nederlands, Português, Português  Brazil, Polski, Русский, Svenska, 
Suomi, Türkçe, Čeština, Українська, 简体中文, 
繁體中文, 日本語, 한국어 

Kenyamanan lainnya Kunci Kensington
Kompatibilitas Plug & Play DDC/CI, sRGB, Windows 7/Windows 8.1/Vista/XP, Mac OSX, Linux
Dudukan
Kemiringan -5/+20

200V4QSB: 
Daya
Mode Aktif 22,9 W (standar), 23,47 W (maks.)
Tidur (Siaga) 0,5W
Tidak Aktif 0,5W
Indikator LED Daya Mode Aktif: Putih, Siaga/Tidur: Putih (Berkedip)
Catu Daya Efek terbakar, 100-240VAC, 50-60Hz

200V4QSBR: 
Daya
Mode Aktif 23,21 W (standar), 24,17 W (maks.)
Tidur (Siaga) 0,5W
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Tidak Aktif 0,5W
Indikator LED Daya Mode Aktif: Putih, Siaga/Tidur: Putih (Berkedip)
Catu Daya Efek terbakar, 100-240VAC, 50-60Hz

Dimensi
Produk dengan dudukan (PxLxT) 479 x 369 x 201 mm
Produk tanpa dudukan (PxLxT) 479 x 299 x 48 mm
Berat
Produk dengan dudukan 2,72kg
Produk tanpa dudukan 2,39kg

Kondisi Pengoperasian
Kisaran suhu (beroperasi) 0°C hingga 40°C
Kisaran suhu (tidak beroperasi) -20°C hingga 60°C
Kelembaban relatif 20% hingga 80%
MTBF 30.000 jam

Lingkungan
ROHS YA
EPEAT(Peraturan dapat berbeda, 
tergantung dari negara Anda)

Silver (www.epeat.net)

Kemasan 100% dapat didaur ulang
Bahan Kimia Khusus Rangka 00% bebas PVC BFR
Energy Star(Peraturan dapat berbeda, 
tergantung dari negara Anda)

YA

Kesesuaian dan standar
Pengesahan Peraturan CE Mark, FCC Class B, TCO Certified, ETL, ISO9241-

307,EPA, UKRAINIAN,CEL, China RoHS, CCC, CECP, PSB, 
WEEE, CU,C-tick

Kabinet
Warna Hitam
Lapisan Luar Mengkilap/Bertekstur

	 Catatan
1.	 EPEAT Gold atau Silver hanya berlaku di lokasi tempat produk Philips terdaftar. Untuk status 

registrasi di negara Anda, kunjungi www. epeat.net.
2.	 Informasi ini dapat berubah tanpa pemberitahuan sebelumnya. Untuk men-download selebaran versi 

terbaru, kunjungi www.philips.com/support.
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4.1	 Mode Resolusi & Preset

	 Maximum Resolution
    1920 × 1080 @ 60 Hz (analog input) 
    1920 × 1080 @ 60 Hz (digital input)

	 Recommended Resolution

	 1920 × 1080 @ 60 Hz (digital input)

H. freq (kHz) Resolution V. freq (Hz)

31.47 720 × 400 70.09

31.47 640 × 480 59.94

35.00 640 × 480 66.67

37.86 640 × 480 72.81

37.50 640 × 480 75.00

37.88 800 × 600 60.32

46.88 800 × 600 75.00

48.36 1024 × 768 60.00

60.02 1024 × 768 75.03

44.77 1280 × 720 59.86

63.98 1280 × 1024 60.02

79.98 1280 × 1024 75.03

55.94 1440 × 900 59.89

70.64 1440 × 900 74.98

65.29 1680 × 1050 59.95

67.50 1920 × 1080 60.00

	 Note 
Please notice that your display works best at 
native resolution of 1920 × 1080 @ 60Hz. For 
best display quality,please follow this resolution 
recommendation. 
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5.	 Manajemen Daya
Jika PC dilengkapi perangkat lunak yang 
terinstal atau kartu tampilan yang terpasang 
sesuai dengan DPM VESA, monitor secara 
otomatis dapat mengurangi pemakaian daya 
saat tidak digunakan. Jika terdapat input dari 
keyboard, mouse, atau perangkat input lainnya 
yang terdeteksi, monitor akan 'bangun' secara 
otomatis. Tabel berikut menunjukkan pemakaian 
daya dan pemberian sinyal dari fitur hemat daya 
otomatis ini:

200V4QSB: 

Ketentuan Manajemen Daya
Mode 
VESA Video Sinkronisasi 

horizontal 
Sinkronisasi 

vertikal 
Daya yang 
Digunakan

Warna 
LED

Aktif AKTIF Ya Ya 22,9W (standar) Putih

Tidur TIDAK 
AKTIF Tidak Tidak 0,5W (standar) Putih 

(berkedip)

Matikan TIDAK 
AKTIF - - 0,5W (standar) TIDAK 

AKTIF

200V4QSBR: 

Ketentuan Manajemen Daya
Mode 
VESA Video Sinkronisasi 

horizontal 
Sinkronisasi 

vertikal 
Daya yang 
Digunakan

Warna 
LED

Aktif AKTIF Ya Ya 23,21W (standar) Putih

Tidur TIDAK 
AKTIF Tidak Tidak 0,5W (standar) Putih 

(berkedip)

Matikan TIDAK 
AKTIF - - 0,5W (standar) TIDAK 

AKTIF

Berikut adalah konfigurasi yang digunakan untuk 
menghitung pemakaian daya pada monitor.

•	 Resolusi asli: 1920×1080

•	 Kontras: 50%

•	 Kecerahan: 250 nit 

•	 Suhu warna: 6.500k dengan pola putih 
sepenuhnya

	 Catatan
Informasi ini dapat berubah tanpa 
pemberitahuan sebelumnya.
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6.	 Informasi Peraturan
(Peraturan dapat berbeda, tergantung dari 
negara Anda)

Congratulations!

This product is TCO Certified - for Sustainable 
IT

TCO Certified is an international 
third party sustainability certification 
for IT products. TCO Certified. 

ensures that the manufacture, use and recycling 
of IT products reflect environmental, social and 
economic responsibility. Every TCO Certified 
product model is verified by an accredited 
independent test laboratory. 

This product has been verified to meet all the 
criteria in TCO Certified, including: 

•	 Corporate Social Responsibility  
Socially responsible production - working 
conditions and labor law in manufacturing 
country 

•	 Energy Efficiency  
Energy efficiency of product and power 
supply. Energy Star compliant, where 
applicable

•	 Environmental Management System 
Manufacturer must be certified according 
to either ISO 14001 or EMAS  

•	 Minimization of Hazardous Substances  
Limits on cadmium, mercury, lead 
& hexavalent chromium including 
requirements for mercury-free products, 
halogenated substances and hazardous 
flame retardants 

•	 Design for Recycling  
Coding of plastics for easy recycling. Limit 
on the number of different plastics used.  

•	 Product Lifetime, Product Take Back  
Minimum one-year product warranty. 
Minimum three-year availability of spare 
parts. Product takeback 

•	 Packaging  
Limits on hazardous substances in product 
packaging. Packaging prepared for recycling 

•	 Ergonomic, User-centered design  
Visual ergonomics in products with a 
display. Adjustability for user comfort 
(displays, headsets)  Acoustic performance 
– protection against sound spikes 
(headsets) and fan noise (projectors, 
computers) Ergonomically designed 
keyboard (notebooks) 

•	 Electrical Safety, minimal electro-magnetic 
Emissions  Third Party Testing  
All certified product models have been 
tested in an independent, accredited 
laboratory.   

A detailed criteria set is available for download 
at www.tcodevelopment.com, where you can 
also find a searchable database of all TCO 
Certified IT products.  

TCO Development, the organization behind 
TCO Certified, has been an international 
driver in the field of Sustainable IT for 20 years. 
Criteria in TCO Certified are developed in 
collaboration with scientists, experts, users 
and manufacturers. Organizations around the 
world rely on TCO Certified as a tool to help 
them reach their sustainable IT goals. We are 
owned by TCO, a non-profit organization 
representing office workers. TCO Development 
is headquartered in Stockholm, Sweden, with 
regional presence in North America and Asia. 

For displays with glossy bezels, the user should 
consider the placement of the display as the 
bezel may cause disturbing reflections from 
surrounding light and bright surfaces.

For more information, please visit   
www.tcodevelopment.com 

Technology for you and the planet

(Only for selective models)
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Lead-free Product

Lead free display promotes 
environmentally sound recovery 
and disposal of waste from electrical 
and electronic equipment. Toxic 

substances like Lead has been eliminated 
and compliance with European community’s 
stringent RoHs directive mandating restrictions 
on hazardous substances in electrical and 
electronic equipment have been adhered to 
in order to make Philips monitors safe to use 
throughout its life cycle.

EPEAT

(www.epeat.net)

The EPEAT (Electronic 
Product Environmental 
Assessment Tool) program 
evaluates computer 

desktops, laptops, and monitors based on 
51 environmental criteria developed through 
an extensive stakeholder consensus process 
supported by US EPA.

EPEAT system helps purchasers in the public 
and private sectors evaluate, compare and 
select desktop computers, notebooks and 
monitors based on their environmental 
attributes. EPEAT also provides a clear and 
consistent set of performance criteria for the 
design of products, and provides an opportunity 
for manufacturers to secure market recognition 
for efforts to reduce the environmental impact 
of its products.

Benefits of EPEAT

Reduce use of primary materials 
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT’S 
requirement that all registered products meet 
ENERGY STAR’s energy efficiency specifications, 
means that these products will consume less 
energy throughout their life.

CE Declaration of Conformity

This product is in conformity with the following 
standards 

•	 EN60950-1:2006+A11:2009+A1:20
10+A12:2011 (Safety requirement of 
Information Technology Equipment).

•	 EN55022:2010 (Radio Disturbance 
requirement of Information Technology 
Equipment).

•	 EN55024:2010 (Immunity requirement of 
Information Technology Equipment).

•	 EN61000-3-2:2006 +A1:2009+A2:2009 
(Limits for Harmonic Current Emission).

•	 EN61000-3-3:2008 (Limitation of Voltage 
Fluctuation and Flicker) following provisions 
of directives applicable.

•	 2006/95/EC (Low Voltage Directive).

•	 2004/108/EC (EMC Directive).

•	 2009/125/EC (ErP Directive, EC No. 
1275/2008 Implementing Directive 
for Standby and Off mode power 
consumption) and is produced by a 
manufacturing organization on ISO9000 
level.

The product also comply with the following 
standards 

•	 ISO9241-307:2008 (Ergonomic 
requirement, Analysis and compliance test 
methods for electronic visual displays).

•	 GS EK1-2000:2011 (GS mark requirement).

•	 prEN50279:1998 (Low Frequency Electric 
and Magnetic fields for Visual Display).

•	 MPR-II (MPR:1990:8/1990:10 Low 
Frequency Electric and Magnetic fields).

•	 TCO CERTIFIED (Requirement for 
Environment Labeling of Ergonomics, 
Energy, Ecology and Emission, TCO: Swedish 
Confederation of Professional Employees) 
for TCO versions.
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Energy Star Declaration

(www.energystar.gov)

As an ENERGY STAR® Partner, we 
have determined that this product 
meets the ENERGY STAR® 
guidelines for energy efficiency.

	 Note
We recommend you switch off the monitor 
when it is not in use for a long time.

Federal Communications Commission (FCC) 
Notice (U.S. Only)

	 This equipment has been tested and found 
to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC 
Rules. These limits are designed to provide 
reasonable protection against harmful 
interference in a residential installation. 
This equipment generates, uses and can 
radiate radio frequency energy and, if not 
installed and used in accordance with the 
instructions, may cause harmful interference 
to radio communications.  
 
However, there is no guarantee that 
interference will not occur in a particular 
installation. If this equipment does cause 
harmful interference to radio or television 
reception, which can be determined by 
turning the equipment off and on, the 
user is encouraged to try to correct 
the interference by one or more of the 
following measures: 

•	 Reorient or relocate the receiving antenna.

•	 Increase the separation between the 
equipment and receiver.

•	 Connect the equipment into an outlet on 
a circuit different from that to which the 
receiver is connected.

•	 Consult the dealer or an experienced 
radio/TV technician for help.

	 Changes or modifications not expressly 
approved by the party responsible for 
compliance could void the user's authority 
to operate the equipment.

Use only RF shielded cable that was supplied 
with the monitor when connecting this monitor 
to a computer device.

To prevent damage which may result in fire or 
shock hazard, do not expose this appliance to 
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS 
ALL REQUIREMENTS OF THE CANADIAN 
INTERFERENCE-CAUSING EQUIPMENT 
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked 
with FCC Logo, 

United States Only

This device complies with Part 15 of the FCC 
Rules. Operation is subject to the following 
two conditions: (1) this device may not cause 
harmful interference, and (2) this device must 
accept any interference received, including 
interference that may cause undesired 
operation.

Commission Federale de la Communication 
(FCC Declaration)

	 Cet équipement a été testé et déclaré 
conforme auxlimites des appareils 
numériques de class B,aux termes de l'article 
15 Des règles de la FCC. Ces limites sont 
conçues de façon à fourir une  protection 
raisonnable contre les interférences nuisibles 
dans le cadre d'une installation résidentielle.  
 
CET appareil produit, utilise et peut émettre 
des hyperfréquences qui, si l'appareil n'est 
pas installé et utilisé selon les consignes 
données, peuvent causer des interférences 

www.energystar.gov
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nuisibles aux communications radio.  
Cependant, rien ne peut garantir l'absence 
d'interférences dans le cadre d'une 
installation particulière. Si cet appareil est 
la cause d'interférences nuisibles pour 
la réception des signaux de radio ou de 
télévision, ce qui peut être décelé en 
fermant l'équipement, puis en le remettant 
en fonction, l'utilisateur pourrait essayer de 
corriger la situation en prenant les mesures 
suivantes:

•	 Réorienter ou déplacer l’antenne de 
réception.

•	 Augmenter la distance entre l’équipement 
et le récepteur.

•	 Brancher l’équipement sur un autre circuit 
que celui utilisé par le récepteur.

•	 Demander l’aide du marchand ou d’un 
technicien chevronné en radio/télévision.

	 Toutes modifications n'ayant pas reçu 
l'approbation des services compétents 
en matière de conformité est susceptible 
d'interdire à l'utilisateur l'usage du présent 
équipement.

N'utiliser que des câbles RF armés pour 
les connections avec des ordinateurs ou 
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE 
B RESPECTE TOUTES LES EXIGENCES DU 
REGLEMENT SUR LE MATERIEL BROUILLEUR 
DU CANADA.

EN 55022 Compliance (Czech Republic Only)

Polish Center for Testing and Certification 
Notice

The equipment should draw power from a 
socket with an attached protection circuit (a 
three-prong socket). All equipment that works 
together (computer, monitor, printer, and so 
on) should have the same power supply source.

The phasing conductor of the room's electrical 
installation should have a reserve short-circuit 
protection device in the form of a fuse with a 
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the 
power supply cable must be removed from the 
power supply socket, which should be located 
near the equipment and easily accessible.

A protection mark "B" confirms that the 
equipment is in compliance with the protection 
usage requirements of standards PN-93/
T-42107 and PN-89/E-06251.
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North Europe (Nordic Countries) Information

Placering/Ventilation 
VARNING:
FÖRSÄKRA DIG OM ATT HUVUDBRYTARE 
OCH UTTAG ÄR LÄTÅTKOMLIGA, NÄR 
DU STÄLLER DIN UTRUSTNING PÅPLATS.

Placering/Ventilation 
ADVARSEL: 
SØRG VED PLACERINGEN FOR, AT 
NETLEDNINGENS STIK OG STIKKONTAKT 
ER NEMT TILGÆNGELIGE. 

Paikka/Ilmankierto 
VAROITUS: 
SIJOITA LAITE SITEN, ETTÄ VERKKOJOHTO 
VOIDAAN TARVITTAESSA HELPOSTI 
IRROTTAA PISTORASIASTA. 

Plassering/Ventilasjon 
ADVARSEL: 
NÅR DETTE UTSTYRET PLASSERES, MÅ 
DU PASSE PÅ AT KONTAKTENE FOR 
STØMTILFØRSEL ER LETTE Å NÅ.

BSMI Notice (Taiwan Only)

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht 
den in der "Verordnung über den Schutz vor 
Schäden durch Röntgenstrahlen" festgelegten 
Vorschriften.

Auf der Rückwand des Gerätes befindet sich 
ein Aufkleber, der auf die Unbedenklichkeit der 
Inbetriebnahme hinweist, da die Vorschriften 
über die Bauart von Störstrahlern nach Anlage 
III ¤ 5 Abs. 4 der Röntgenverordnung erfüllt 
sind. 

Damit Ihr Monitor immer den in der Zulassung 
geforderten Werten entspricht, ist darauf zu 
achten, daß

1.	 Reparaturen nur durch Fachpersonal 
durchgeführt werden.

2.	 	nur original-Ersatzteile verwendet werden. 

3.	 	bei Ersatz der Bildröhre nur eine 
bauartgleiche eingebaut wird.

Aus ergonomischen Gründen wird empfohlen, 
die Grundfarben Blau und Rot nicht auf 
dunklem Untergrund zu verwenden (schlechte 
Lesbarkeit und erhöhte Augenbelastung bei zu 
geringem Zeichenkontrast wären die Folge). 
Der arbeitsplatzbezogene Schalldruckpegel 
nach DIN 45 635 beträgt 70dB (A) oder 
weniger. 

	 ACHTUNG: BEIM AUFSTELLEN 
DIESES GERÄTES DARAUF 
ACHTEN, DAß NETZSTECKER UND 
NETZKABELANSCHLUß LEICHT 
ZUGÄNGLICH SIND. 

Restriction on Hazardous Substances 
statement (India) 

This product complies with the “India E-waste 
Rule 2011” and prohibits use of lead, mercury, 
hexavalent chromium, polybrominated 
biphenyls or polybrominated diphenyl ethers 
in concentrations exceeding 0.1 weight % and 
0.01 weight % for cadmium, except for the 
exemptions set in Schedule 2 of the Rule.
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E-Waste Declaration for India

This symbol on the product or on its packaging 
indicates that this product must not be 
disposed of with your other household waste. 
Instead it is your responsibility to dispose of 
your waste equipment by handing it over to 
a designated collection point for the recycling 
of waste electrical and electronic equipment . 
The separate collection and recycling of your 
waste equipment at the time of disposal will 
help to conserve natural resources and ensure 
that it is recycled in a manner that protects 
human health and the environ-ment. For more 
information about where you can drop off your 
waste equipment for recycling in India please 
visit the below web link.

http://www.india.philips.com/about/sustainability/
recycling/index.page

Information for U.K. only

WARNING - THIS APPLIANCE MUST BE 
EARTHED.

Important:

This apparatus is supplied with an approved 
moulded 13A plug. To change a fuse in this 
type of plug proceed as follows:

1.	 Remove fuse cover and fuse.

2.	 Fit new fuse which should be a BS 1362 
5A,A.S.T.A. or BSI approved type.

3.	 Retit the fuse cover.

If the fitted plug is not suitable for your socket 
outlets, it should be cut off and an appropriate 
3-pin plug fitted in its place.

If the mains plug contains a fuse, this should 
have a value of 5A. If a plug without a fuse is 

used, the fuse at the distribution board should 
not be greater than 5A.

NOTE: The severed plug must be destroyed 
to avoid a possible shock hazard 
should it be inserted into a 13A socket 
elsewhere.

(A)

(B)

How to connect a plug

The wires in the mains lead are coloured in 
accordance with the following code:

BLUE -“NEUTRAL”(“N”)

BROWN -“LIVE”(“L”)

GREEN&YELLOW -“EARTH”(“E”)

1.	 The GREEN&YELLOW wire must be 
connected to the terminal in the plug 
which is marked with the letter "E" or by 
the Earth symbol or coloured GREEN or 
GREEN&YELLOW.

2.	 The BLUE wire must be connected to the 
terminal which is marked with the letter 
"N" or coloured BLACK.

3.	 The BROWN wire must be connected 
to the terminal which is marked with the 
letter "L" or coloured RED.

Before replacing the plug cover, make certain 
that the cord grip is clamped over the sheath of 
the lead - not simply over the three wires.
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-

China RoHS 

The People's Republic of China released a 
regulation called "Management Methods for 
Controlling Pollution by Electronic Information 
Products" or commonly referred to as China 
RoHS. All products produced and sold for 
China market have to meet China RoHS 
request.

中国电子信息产品污染控制标识要求(中国
RoHS法规标示要求)产品中有毒有害物质或
元素的名称及含量

部件名称

有毒有害物质或元素

铅 
(Pb)

汞 
(Hg)

镉 
(Cd)

六价铬 
(Cr6+)

多溴联苯 
(PBB)

多溴二苯醚
(PBDE)

外壳 O O O O O O

液晶显示屏/灯管 X O O O O O

电路板组件* X O O O O O

电源适配线 X O O O O O

电源线/连接线 X O O O O O

*:	� 电路板组件包括印刷电路板及其构成的零部件，如电阻、电容、集成电
路、连接器等。

O:	� 表示该有毒有害物质在该部件所有均质材料中的含量均在GB/T26572-
2011规定的限量要求以下。

X:	� 表示该有毒有害物质至少在该部件的某一均质材料中的含量超出GB/
T26572-2011规定的限量要求；但是上表中打“X”的部件，符合欧盟RoHS
法规要求（属于豁免的部分）。

环保使用期限 

此标识指期限 ( 十年 ), 电子信息产品中含有
的有毒有害物质或元素在正常使用的条件
下不会发生外泄或突变 , 电子信息产品用户
使用该电子信息产品不会对环境造成严重
污染或对其人身、 财产造成严重损害的期
限．

中国能源效率标识 
根据中国大陆《能源效率标识管理办法》，本显示器符合以下要求：

关闭状态能耗（W)
能源效率(cd/W)

< 0.5
> 1.05

1级
GB 21520-2008

能效等级
能效标准

详细有关信息请查阅中国能效标识网：http://www.energylabel.gov.cn/

《废弃电器电子产品回收处理管理条例》提示性
说明

为了更好地关爱及保护地球，当用户不再需要此
产品或产品寿命终止时，请遵守国家废弃电器电
子产品回收处理相关法律法规，将其交给当地具
有国家认可的回收处理资质的厂商进行回收处

理。

EU Energy Label

The European Energy Label informs you on 
the energy efficiency class of this product. 
The greener the energy efficiency class of this 
product is the lower the energy it consumes. 

On the label, you can find the energy efficiency 
class, the average power consumption of 
this product in use and the average energy 
consumption for 1 year. 

Note 
The EU Energy Label will be ONLY applied on 
the models bundling with HDMI and TV tuners.
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7.	 �Layanan pelanggan dan 
jaminan

7.1	 Kebijakan Cacat Piksel Monitor 
Panel Datar Philips

Philips berupaya memberikan produk berkualitas 
tertinggi. Kami menggunakan beberapa proses 
produksi tercanggih di industri dan menerapkan 
kontrol kualitas yang ketat. Namun, cacat piksel 
atau subpiksel pada panel LCD TFT yang 
digunakan di monitor panel datar terkadang 
tidak dapat dihindari. Tidak ada produsen yang 
dapat menjamin semua panel akan bebas dari 
cacat piksel, namun Philips menjamin bahwa 
setiap monitor dengan jumlah cacat yang tidak 
dapat diterima akan diperbaiki atau diganti sesuai 
dengan jaminan yang berlaku. Pemberitahuan 
ini menjelaskan berbagai jenis cacat piksel dan 
menentukan tingkat cacat yang dapat diterima 
untuk masing-masing jenis tersebut. Untuk 
memenuhi syarat dalam mendapatkan perbaikan 
atau penggantian sesuai jaminan, jumlah cacat 
piksel pada panel LCD TFT harus melampaui 
tingkat yang dapat diterima. Misalnya, jumlah 
cacat subpiksel pada monitor tidak boleh 
lebih dari 0,0004%. Philips bahkan selanjutnya 
menentukan standar kualitas lebih tinggi untuk 
jenis atau kombinasi cacat piksel tertentu yang 
lebih nyata dibandingkan dengan yang lainnya. 
Kebijakan ini berlaku secara global.

Piksel dan Subpiksel
Piksel, atau elemen gambar, terdiri dari tiga 
subpiksel dalam warna utama merah, hijau, 
dan biru. Kombinasi beberapa piksel akan 
membentuk gambar. Bila semua subpiksel pada 
piksel menyala, kombinasi ketiga subpiksel 
berwarna tersebut akan muncul sebagai satu 
piksel putih. Bila semua mati, kombinasi ketiga 

subpiksel berwarna akan muncul sebagai satu 
piksel hitam. Kombinasi lainnya dari subpiksel 
yang menyala dan mati akan muncul sebagai satu 
piksel warna lain.

Jenis Cacat Piksel
Cacat piksel dan subpiksel muncul di layar dalam 
berbagai bentuk. Ada dua kategori cacat piksel 
dan masing-masing kategori tersebut terdiri dari 
beberapa jenis cacat subpiksel.

Cacat Titik Terang
Cacat titik terang muncul sebagai piksel maupun 
subpiksel yang selalu terang atau 'menyala'. 
Karenanya, titik terang merupakan subpiksel yang 
terlihat jelas di layar bila monitor menampilkan 
pola gelap. Berikut adalah jenis cacat titik terang:

Satu subpiksel merah, hijau, atau biru terang

Dua subpiksel terang yang berdekatan:
-- Merah + Biru = Ungu
-- Merah + Hijau = Kuning
-- Hijau + Biru = Cyan (Biru Muda)

Tiga subpiksel terang yang berdekatan (satu 

Subpiksel Subpiksel Subpiksel

piksel



29

7. Layanan pelanggan dan jaminan

CACAT TITIK TERANG TINGKAT YANG DAPAT DITERIMA
1 subpiksel terang 3
2 subpiksel terang yang berdekatan 1
3 subpiksel terang yang berdekatan (satu piksel putih) 0
Jarak di antara dua cacat titik terang* >15mm
Total cacat titik terang dari semua jenis 3

CACAT TITIK GELAP TINGKAT YANG DAPAT DITERIMA
1 subpiksel gelap 5 atau lebih sedikit
2 subpiksel gelap yang berdekatan 2 atau lebih sedikit
3 subpiksel gelap yang berdekatan 0
Jarak di antara dua cacat titik gelap* >15mm
Total cacat titik gelap dari semua jenis 5 atau lebih sedikit

TOTAL CACAT TITIK TINGKAT YANG DAPAT DITERIMA
Total cacat titik terang atau titik gelap dari semua jenis 5 atau lebih sedikit

	 Catatan 
1.	 1 atau 2 cacat subpiksel yang berdekatan = 1 cacat titik
2.	 Monitor ini sesuai dengan ISO 9241-307. (ISO9241-307: Metode pengujian kesesuaian, analisis, dan 

persyaratan ergonomis untuk tampilan visual elektronik)
3.	 ISO9241-307 adalah pengganti standar ISO13406 yang sebelumnya dikenal, setelah ditarik oleh 

International Organisation for Standardisation (ISO) sejak tanggal 13-11-2008.

piksel putih)
	 Catatan

Titik terang merah atau biru harus lebih dari 50 
persen lebih terang daripada titik di sekitarnya, 
sedangkan titik terang hijau 30 persen lebih 
terang daripada titik di sekitarnya.

Cacat Titik Gelap
Cacat titik gelap muncul sebagai piksel maupun 
subpiksel yang selalu gelap atau 'mati'. Karenanya, 
titik gelap merupakan subpiksel yang terlihat 
jelas di layar bila monitor menampilkan pola 
terang. Berikut adalah jenis cacat titik gelap:

Jarak Cacat Piksel  
Karena cacat piksel dan subpiksel sejenis yang 
saling berdekatan mungkin terlihat lebih nyata, 
Philips juga menentukan toleransi untuk jarak 
cacat piksel.

Toleransi Cacat Piksel
Untuk memenuhi syarat dalam mendapatkan 
perbaikan atau penggantian karena cacat piksel 
selama masa berlaku jaminan, panel LCD TFT 
pada monitor panel datar Philips harus memiliki 
cacat piksel maupun subpiksel melebihi toleransi 
yang tercantum dalam tabel berikut ini.
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7.2	 Layanan pelanggan dan jaminan

Untuk informasi rinci tentang cakupan jaminan dan persyaratan dukungan tambahan yang berlaku di 
negara Anda, kunjungi situs Web www.philips.com/support. Anda juga dapat menghubungi nomor 
Pusat Layanan Pelanggan Philips setempat yang tercantum di bawah ini.

Informasi kontak untuk kawasan EROPA BARAT:

Negara CSP Nomor hotline Harga Jam operasional

Austria RTS +43 0810 000206 € 0.07 Mon to Fri : 9am - 6pm

Belgium Ecare +32 078 250851 € 0.06 Mon to Fri : 9am - 6pm

Cyprus Alman 800 92 256 Free of charge Mon to Fri : 9am - 6pm

Denmark Infocare +45 3525 8761 Local call tariff Mon to Fri : 9am - 6pm

Finland Infocare  +358 09 2290 1908 Local call tariff Mon to Fri : 9am - 6pm

France Mainteq +33 082161 1658 € 0.09 Mon to Fri : 9am - 6pm

Germany RTS +49 01803 386 853 € 0.09 Mon to Fri : 9am - 6pm

Greece Alman +30 00800 3122 1223 Free of charge Mon to Fri : 9am - 6pm

Ireland Celestica +353 01 601 1161 Local call tariff Mon to Fri : 8am - 5pm

Italy Anovo Italy +39 840 320 041 € 0.08 Mon to Fri : 9am - 6pm

Luxembourg Ecare +352 26 84 30 00 Local call tariff Mon to Fri : 9am - 6pm

Netherlands Ecare +31 0900 0400 063 € 0.10 Mon to Fri : 9am - 6pm

Norway Infocare +47 2270 8250 Local call tariff Mon to Fri : 9am - 6pm

Poland MSI +48 0223491505 Local call tariff Mon to Fri : 9am - 6pm

Portugal Mainteq 800 780 902 Free of charge Mon to Fri : 8am - 5pm

Spain Mainteq +34 902 888 785 € 0.10 Mon to Fri : 9am - 6pm

Sweden Infocare +46 08 632 0016 Local call tariff Mon to Fri : 9am - 6pm

Switzerland ANOVO CH +41 02 2310 2116 Local call tariff Mon to Fri : 9am - 6pm

United Kingdom Celestica +44 0207 949 0069 Local call tariff Mon to Fri : 8am - 5pm

Informasi kontak untuk China:

Negara Pusat informasi Nomor layanan konsumen

China PCCW Limited 4008 800 008

Informasi kontak untuk AMERIKA UTARA:

Negara Pusat informasi Nomor layanan konsumen

U.S.A. EPI-e-center (877) 835-1838

Canada EPI-e-center (800) 479-6696
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Informasi kontak untuk kawasan EROPA TENGAH DAN TIMUR:

Negara
Pusat 
informasi CSP Nomor layanan konsumen

Belarus NA IBA
+375 17 217 3386 
+375 17 217 3389

Bulgaria NA LAN Service +359 2 960 2360

Croatia NA MR Service Ltd +385 (01) 640 1111

Czech Rep. NA Asupport 420 272 188 300

Estonia NA FUJITSU
+372 6519900(General) 
+372 6519972(workshop)

Georgia NA Esabi +995 322 91 34 71

Hungary NA Profi Service

+36 1 814 8080(General) 
+36 1814 8565(For AOC&Philips 
only)

Kazakhstan NA Classic Service I.I.c. +7 727 3097515

Latvia NA ServiceNet LV
+371 67460399 
+371 27260399

Lithuania
NA

UAB Servicenet
+370 37 400160(general) 
+370 7400088 (for Philips)

Macedonia NA AMC +389 2 3125097

Moldova NA Comel +37322224035

Romania NA Skin +40 21 2101969

Russia NA CPS +7 (495) 645 6746

Serbia&Montenegro NA Kim Tec d.o.o. +381 11 20 70 684

Slovakia NA Datalan Service +421 2 49207155

Slovenia NA PC H.and +386 1 530 08 24

the republic of Belarus NA ServiceBy + 375 17 284 0203

Turkey NA Tecpro +90 212 444 4 832 

Ukraine NA Topaz +38044 525 64 95

Ukraine NA Comel +380 5627444225

Informasi kontak untuk kawasan AMERIKA LATIN:

Negara Pusat informasi Nomor layanan konsumen

Brazil
Vermont

0800-7254101

Argentina 0800 3330 856
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Informasi kontak untuk kawasan APMEA:

Negara ASP Nomor layanan konsumen Jam operasional

Australia AGOS NETWORK PTY LTD 1300 360 386 Mon.~Fri. 9:00am-5:30pm

New Zealand Visual Group Ltd. 0800 657447 Mon.~Fri. 8:30am-5:30pm

Hong Kong 
Macau

Company: Smart Pixels 
Technology Ltd.

Hong Kong: 
Tel: +852 2619 9639 
Macau:Tel: (853)-0800-987

Mon.~Fri. 9:00am-6:00pm  
Sat. 9:00am-1:00pm

India REDINGTON INDIA LTD
Tel: 1 800 425 6396 
SMS: PHILIPS to 56677 

Mon.~Fri. 9:00am-5:30pm

Indonesia
PT. CORMIC SERVISINDO 
PERKASA

+62-21-4080-9086 (Customer 
Hotline) 
+62-8888-01-9086 (Customer 
Hotline)

Mon.~Thu. 08:30-12:00; 
13:00-17:30  
Fri. 08:30-11:30; 13:00-17:30

Korea Alphascan Displays, Inc 1661-5003
Mon.~Fri. 9:00am-5:30pm 
Sat. 9:00am-1:00pm

Malaysia R-Logic Sdn Bhd +603 5102 3336
Mon.~Fri. 8:15am-5:00pm 
Sat. 8:30am-12:30am

Pakistan TVONICS Pakistan +92-213-6030100 Sun.~Thu. 10:00am-6:00pm

Singapore
Philips Electronics Singapore 
Pte Ltd (Philips Consumer Care 
Center)

(65) 6882 3966
Mon.~Fri. 9:00am-6:00pm 
Sat. 9:00am-1:00pm

Taiwan FETEC.CO 0800-231-099 Mon.~Fri. 09:00 - 18:00

Thailand
Axis Computer System Co., 
Ltd.

(662) 934-5498 Mon.~Fri. 8:30am~05:30pm

South Africa Computer Repair Technologies 011  262 3586 Mon.~Fri. 8:00am~05:00pm

Israel Eastronics LTD 1-800-567000 Sun.~Thu. 08:00-18:00 

Vietnam
FPT Service Informatic 
Company Ltd. - Ho Chi Minh 
City Branch

+84 8 38248007 Ho Chi Minh 
City 
+84 5113.562666 Danang City 
+84 5113.562666 Can tho 
Province

Mon.~Fri. 8:00-12:00, 13:30-
17:30,Sat. 8:00-12:00

Philippines
EA Global Supply Chain 
Solutions ,Inc.

(02) 655-7777; 6359456 Mon.~Fri. 8:30am~5:30pm

Armenia 
Azerbaijan 
Georgia 
Kyrgyzstan 
Tajikistan

Firebird service centre +97 14 8837911 Sun.~Thu. 09:00 - 18:00

Uzbekistan
Soniko Plus Private Enterprise 
Ltd

+99871 2784650 Mon.~Fri. 09:00 - 18:00

Turkmenistan Technostar Service Centre +(99312) 460733, 460957 Mon.~Fri. 09:00 - 18:00

Japan
フィリップスモニター・サ
ポ ートセンター

0120-060-530 Mon.~Fri. 10:00 - 17:00
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8.	 �Mengatasi masalah & Tanya 
jawab

8.1	 Mengatasi Masalah
Halaman ini menjelaskan tentang masalah yang 
dapat diatasi pengguna. Jika masalah terus 
berlanjut setelah Anda mencoba solusi berikut, 
hubungi staf layanan pelanggan Philips.

	 Masalah Umum

Tidak Ada Gambar (LED Daya mati)

•	 Pastikan kabel daya telah tersambung ke 
stopkontak dan ke bagian belakang monitor.

•	 Pastikan terlebih dulu tombol daya di bagian 
depan monitor telah berada dalam posisi 
OFF (TIDAK AKTIF), lalu tekan ke posisi 
ON (AKTIF).

Tidak Ada Gambar (LED Daya Putih)

•	 Pastikan komputer telah dihidupkan.

•	 Pastikan kabel sinyal telah tersambung 
dengan benar ke komputer.

•	 Pastikan pin pada kabel monitor yang 
tersambung tidak tertekuk. Jika ya, perbaiki 
atau ganti kabel.

•	 Fitur Hemat Daya mungkin diaktifkan

Layar menampilkan

Attention

Check cable connection

•	 Pastikan kabel monitor telah tersambung 
dengan benar ke komputer. (Lihat juga 
Panduan Ringkas).

•	 Periksa pin yang tertekuk pada kabel 
monitor.

•	 Pastikan komputer telah dihidupkan.

Tombol AUTO (OTOMATIS) tidak berfungsi

•	 Fungsi otomatis hanya berlaku dalam mode 
Analog VGA. Jika hasilnya tidak memuaskan, 

Anda dapat melakukan penyesuaian manual 
melalui menu OSD.

	 Catatan
Fungsi Otomatis tidak berlaku dalam mode 
Digital DVI karena fungsi tersebut tidak 
diperlukan.

Tanda yang tampak seperti asap atau kilatan api

•	 Jangan lakukan langkah-langkah apapun 
untuk mengatasi masalah

•	 Lepaskan segera monitor dari catu daya 
utama untuk keselamatan

•	 Hubungi segera staf layanan pelanggan Philips.

	 Masalah Gambar

Gambar tidak berada di tengah

•	 Atur posisi gambar menggunakan fungsi 
“Auto” (Otomatis) dalam Kontrol Utama 
OSD.

•	 Atur posisi gambar menggunakan Phase/
Clock (Fase/Jam) dalam Setup (Konfigurasi) 
di Kontrol Utama OSD. Hal ini hanya 
berlaku dalam mode VGA.

Gambar bergetar di layar
Pastikan kabel sinyal telah tersambung dengan 
benar dan kencang ke papan grafis atau PC.

Kelip vertikal muncul di layar

•	 Atur gambar menggunakan fungsi “Auto” 
(Otomatis) dalam Kontrol Utama OSD.

•	 Hilangkan baris vertikal menggunakan 
Phase/Clock (Fase/Jam) dalam Setup 
(Konfigurasi) di Kontrol Utama OSD. Hal ini 
hanya berlaku dalam mode VGA.

Kelip horizontal muncul di layar

•	 Atur gambar menggunakan fungsi “Auto” 
(Otomatis) dalam Kontrol Utama OSD.
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•	 Hilangkan baris vertikal menggunakan 

Phase/Clock (Fase/Jam) dalam Setup 
(Konfigurasi) di Kontrol Utama OSD. Hal ini 
hanya berlaku dalam mode VGA.

Gambar terlihat buram, tidak jelas, atau terlalu 
gelap

•	 Atur kontras dan kecerahan di OSD (On-
Screen Display).

"Jejak gambar", "efek terbakar", atau "bayangan" 
tetap muncul setelah daya dimatikan.

•	 Tampilan gambar diam atau gambar statis 
yang tidak berubah dalam waktu lama 
dapat menimbulkan “efek terbakar”, disebut 
juga “jejak gambar” atau “bayangan”, di 
layar. “Efek terbakar”, “jejak gambar”, atau 
“bayangan” adalah fenomena umum dalam 
teknologi panel monitor. Dalam sebagian 
besar kasus, “efek terbakar”, “jejak gambar”, 
atau “bayangan” akan menghilang secara 
bertahap dalam waktu tertentu setelah daya 
dimatikan.

•	 Aktifkan selalu program screensaver 
bergerak bila Anda meninggalkan monitor.

•	 Aktifkan selalu aplikasi refresh layar berkala 
jika Monitor akan menampilkan konten 
statis yang tidak berubah.

•	 Gejala “efek terbakar”, “jejak gambar”, atau 
“bayangan” yang fatal tidak akan hilang 
dan tidak dapat diperbaiki. Kerusakan yang 
disebutkan di atas tidak tercakup dalam 
jaminan.

Gambar tampak berubah.  Teks tidak jelas atau 
buram.

•	 Atur resolusi layar PC ke mode sama seperti 
resolusi asli layar yang disarankan monitor.

Titik hijau, merah, biru, hitam, dan putih muncul 
di layar

•	 Titik tersisa adalah karakter normal yang 
muncul pada liquid crystal yang digunakan 
dalam teknologi saat ini. Untuk informasi 
lebih rinci, lihat kebijakan piksel.

Lampu “daya hidup” terlalu terang dan 

mengganggu

•	 Anda dapat mengatur lampu “daya hidup” 
menggunakan Konfigurasi LED daya dalam 
Kontrol utama OSD.

Untuk bantuan lebih lanjut, lihat daftar Pusat 
Informasi Konsumen dan hubungi staf layanan 
pelanggan Philips.

8.2	 Tanya Jawab Umum

P1:	� Sewaktu memasang monitor, apa 
yang harus saya lakukan jika layar 
menampilkan "Cannot display this video 
mode" (Tidak dapat menampilkan mode 
video ini)?

Jawab:	�Resolusi yang disarankan untuk monitor 
ini:1920X1080 pada 60 Hz.

•	 �Lepas semua kabel, lalu sambungkan PC ke 
monitor yang digunakan sebelumnya.

•	 �Dalam Windows Start Menu (Menu 
Mulai Windows), pilih Settings/Control 
Panel(Pengaturan/Panel Kontrol) . Dalam 
Control Panel Window (Jendela Panel 
Kontrol), pilih ikon Display (Tampilan). 
Dalam Display Control Panel (Panel Kontrol 
Tampilan), pilih tab "Settings" (Pengaturan). 
Dalam tab pengaturan, dalam kotak "desktop 
area" (area desktop), gerakkan panel samping 
ke piksel 1920X1080 

•	 �Buka "Advanced Properties" (Properti 
Lanjutan), atur Kecepatan Refresh ke 60Hz, 
lalu klik OK.

•	 �Hidupkan ulang komputer, lalu ulangi langkah 
2 dan 3 untuk memverifikasi bahwa PC telah 
diatur ke 1920X1080 pada 60 Hz.

•	 �Matikan komputer, lepas monitor lama, lalu 
sambungkan monitor Philips.

•	 �Hidupkan monitor, lalu hidupkan PC.

P2:	� Berapa kecepatan refresh yang 
disarankan untuk Monitor?

Jawab:	�Kecepatan refresh yang disarankan 
untuk Monitor adalah 60Hz. Jika 
terdapat gangguan di layar, Anda 
dapat mengaturnya hingga 75Hz untuk 
mengetahui apakah gangguan tersebut 
dapat diatasi.
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P3:	� Apakah yang dimaksud dengan file .inf 

dan .icm pada CD-ROM?  Bagaimana 
cara menginstal driver (.inf dan .icm)?

Jawab:	�Ini adalah file driver untuk monitor. 
Untuk menginstal driver, ikuti petunjuk 
dalam panduan pengguna. Komputer 
mungkin akan menanyakan driver 
monitor (file .inf dan .icm) atau disk 
driver saat Anda menginstal monitor 
untuk pertama kalinya. Ikuti petunjuk 
tentang cara memasukkan CD-ROM 
pendamping yang disertakan dalam 
kemasan ini. Driver monitor (file .inf dan 
.icm) akan diinstal secara otomatis.

P4:	� Bagaimana cara mengatur resolusi?

Jawab:	�Kombinasi driver grafis/kartu video dan 
monitor akan menentukan resolusi yang 
tersedia. Anda dapat memilih resolusi 
yang diinginkan dalam Panel Kontrol 
Windows® dengan “Display properties” 
(Properti tampilan).

P5:	� Bagaimana jika saya salah melakukan 
penyesuaian monitor melalui OSD?

Jawab:	�Tekan tombol OK, lalu pilih "Reset" (Atur 
Ulang) untuk menggunakan kembali 
semua pengaturan pabrik awal.

P6:	� Apakah layar LCD antigores?

Jawab:	�Secara umum, sebaiknya permukaan 
panel tidak mengalami guncangan yang 
berlebihan dan terlindungi dari benda 
tajam atau tumpul. Sewaktu menangani 
monitor, pastikan tidak ada tekanan atau 
kekuatan berlebihan yang diberikan pada 
sisi permukaan panel. Tindakan ini dapat 
mempengaruhi ketentuan jaminan.

P7:	� Bagaimana seharusnya cara 
membersihkan permukaan LCD?

Jawab:	�Untuk pembersihan normal, gunakan kain 
bersih dan lembut. Untuk pembersihan 
secara menyeluruh, gunakan isopropil 
alkohol. Jangan gunakan bahan pelarut 
lainnya seperti etil alkohol, ethanol, 
aseton, hexane, dll.

P8:	� Apakah pengaturan warna pada 

monitor dapat diubah?

Jawab:	�Ya. Anda dapat mengubah pengaturan 
warna melalui kontrol OSD sesuai 
prosedur berikut,

•	 �Tekan "OK" untuk menampilkan menu OSD 
(On Screen Display)

•	 �Tekan "Down Arrow" (Panah Bawah) untuk 
menggunakan pilihan "Color" (Warna), lalu 
tekan "OK" untuk membuka pengaturan 
warna. Berikut adalah tiga pengaturan yang 
tersedia.
1.	 Color Temperature (Suhu Warna);  

Dua pengaturan suhu warna adalah 
6500K dan 9300K. Dengan pengaturan 
dalam kisaran 6500K, panel menampilkan 
"hangat dengan nada warna merah-putih", 
sedangkan suhu 9300K menghasilkan 
"nada dingin, biru-putih".

2.	 sRGB; Ini adalah pengaturan standar 
untuk memastikan pertukaran warna 
yang benar di antara berbagai perangkat 
(misalnya kamera digital, monitor, printer, 
pemindai, dll.) 

3.	 User Define (Ditentukan Pengguna); 
Pengguna dapat memilih pengaturan 
warna sesuai keinginannya dengan 
menyesuaikan warna merah, hijau, dan 
biru.

	 Catatan:
Penghitungan warna lampu yang dipancarkan 
oleh benda tertentu sewaktu sedang dipanaskan. 
Penghitungan ini diberikan dalam persyaratan 
skala absolut, (derajat Kelvin). Suhu Kelvin lebih 
rendah seperti 2004K berwarna merah; suhu 
lebih tinggi seperti 9300K berwarna biru. Suhu 
netral adalah putih pada 6504K.

P9:	� Apakah Monitor dapat disambungkan 
ke PC manapun, workstation, atau Mac?

Jawab:	�Ya. Semua Monitor Philips kompatibel 
sepenuhnya dengan PC, Mac, dan 
workstation standar. Anda mungkin 
memerlukan adapter kabel untuk 
menyambungkan monitor ke sistem Mac. 
Untuk informasi lebih lanjut, hubungi staf 
penjualan Philips.
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8. Mengatasi masalah & Tanya jawab
P10:	� Apakah Monitor Philips memiliki fungsi 

Plug-and-Play?

Jawab:	�Ya. Monitor merupakan perangkat 
Plug-and-Play yang kompatibel dengan 
Windows 7/Windows 8.1/Vista/XP/NT, 
Mac OSX, Linux

P11:	� Apa yang dimaksud dengan Gambar 
Menempel, Efek Terbakar, Jejak Gambar, 
atau Bayangan pada panel LCD?

Jawab:	�Tampilan gambar diam atau gambar 
statis yang tidak berubah dalam 
waktu lama dapat menimbulkan "efek 
terbakar", disebut juga "jejak gambar" 
atau "bayangan", di layar. "Efek terbakar", 
"jejak gambar", atau "bayangan" adalah 
fenomena umum dalam teknologi panel 
LCD. Dalam sebagian besar kasus, "efek 
terbakar", "jejak gambar", atau "bayangan" 
akan menghilang secara bertahap dalam 
waktu tertentu setelah daya dimatikan.
Aktifkan selalu program screensaver 
bergerak bila Anda meninggalkan 
monitor.
Aktifkan selalu aplikasi refresh layar 
berkala jika Monitor akan menampilkan 
konten statis yang tidak berubah.

	 Peringatan
Kegagalan mengaktifkan screensaver, atau aplikasi 
refresh layar secara berkala dapat menyebabkan 
gejala parah "efek terbakar", "jejak gambar", atau 
bayangan gambar" yang tidak akan menghilang 
dan tidak dapat diperbaiki. Kerusakan yang 
disebutkan di atas tidak tercakup dalam jaminan 
Anda.

P12:	� Mengapa Layar tidak menampilkan teks 
yang jelas, namun menampilkan karakter 
bergerigi?

Jawab:	�Monitor berfungsi paling baik pada 
resolusi asli 1920X1080 pada 60 Hz. 
Untuk tampilan terbaik, gunakan resolusi 
ini.
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